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ABSTRACT

The lake and pond ecology of New Jersey provides an interesting perspective into
the ways that human presence and urbanization affect every aspect of the environment.
While some bodies of water are located within protected forests or wetlands, the vast
majority are surrounded by human-made structures like roads, homes, fields, and parks.
Lakes and ponds located within a forest typically experience a lower volume of pollution,
because surface waters carrying pollutants like fertilizer, road salt, detergent, oil, and
sediment are further away from the water, and are absorbed or redirected by the soil and
vegetation. My research involved asking the question, how does the level of development
around a lake affect the quality of its water? | found that development did not significantly
affect temperature, dissolved oxygen, pH, or water clarity, and there were insufficient data
to determine the effects of development on ammonia, nitrite, and phosphate. However, |
did find that development had a significant impact on the total dissolved solids found in the
lake; as the percentage of developed land within a watershed increased, the average total
dissolved solids also increased. When looking specifically at calcium, magnesium, and
sodium ions, I found that these followed the trend observed in total dissolved solids. One
factor which is likely contributing to this trend is road salt pollution. This type of pollution
occurs during the winter and early spring when temperatures are around or below
freezing, and local municipalities apply sodium chloride salt to the roads to melt snow and
prevent the formation of ice. In late spring, snowmelt and rain will carry the salt from the
roads into bodies of water, where it persists and accumulates over time. Water quality

monitoring is necessary to keep track of the salinity of these freshwater ecosystems, since



the organisms living within them are not adapted to live in saltwater, and high levels of
salinity are toxic to many. Further research into alternatives to sodium chloride road salt,

as well as ways to prevent it from entering New Jersey’s lakes and ponds is recommended.
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INTRODUCTION

Limnology and the Movement of Water

The movement of water around the planet is an integral aspect of life on Earth.
Wright and Boorse (2017) describe the water cycle as follows: on a basic level, water is
filtered and replenished through cycles of precipitation and evaporation; when rain or
snow falls, it can flow downhill to form rivers, lakes, and ponds, or percolate into the
ground and become groundwater. Along the way, some water evaporates, is taken up by
plants, consumed by animals, or used by people. Transpiration from the leaves of plants
and evaporation from surface water and soil replenishes the water vapor in the
atmosphere, where it will condense and fall again. All aspects of this cycle are constantly in
motion, and the climate and terrain of a region will affect when, where, and how frequently
precipitation events occur. The landscape of a region also affects how well water can
infiltrate into the ground, a process which is important to the replenishment of clean
freshwater sources and the prevention of flooding. The process of water filtering through
the soil and rocks removes most of the microorganisms and sediments, and the presence of
trees, plants, and porous soil slow down the speed at which water flows through an area.

The landscape characteristics of an area influence where water travels and how it
flows over the landscape. Lakes and streams are generally representative of the lowest
point in a given area, since water travels downhill with gravity (Wright and Boorse, 2017).
The area where all of the water that falls in a given region collects is known as a watershed
(Black, 1996). A watershed can vary in general size, as well as proportional size to its given

water body, and large ones are often divided into management areas and sub-watershed



zones which contain multiple lentic (still water) and lotic (flowing water) systems that
contribute to a larger system (Black, 1996). An example of this is the Passaic River
watershed in northern New Jersey, which covers roughly 2,400 km of land, and is fed by
multiple tributaries, many of which flow through lakes and ponds before reaching the
Passaic River (New Jersey Center for Water Science and Technology, 2018). At the
narrowest scope is the contribution shed of a lake or pond, which refers to the watershed
specific to one lake or pond.

There are a few key differences between these two types of water bodies. Typically,
water monitoring networks will differentiate lakes as being greater than two hectares (five
acres) in size and at least one meter deep, however the most important aspect of lakes
which sets them apart from ponds is that lakes are stratified, and will undergo periods of
mixing based on regional and seasonal temperature changes (Fafard, 2018; NJDEP, 2020).
In the summer, heat from the sun increases the temperature of the surface water, creating a
warm, less dense surface layer (called the epilimnion), a less warm, slightly denser middle
layer (called the metalimnion), and a cool, dense layer (called the hypolimnion) (Fafard,
2018). In the fall, surface water temperatures decrease and the layers mix together, which
allows for dissolved oxygen to reach the bottom of the lake more easily (Fafard, 2018). In
the winter, a new type of stratification is established; because water is the most dense at
4°C, the warmest layer is at the bottom of the lake, and the coldest layer is near the surface,
where ice forms (Fafard, 2018). In the spring, a similar mixing event happens as does in the
fall, where surface water temperatures increase slightly and the layers can mix together,
redistributing nutrients and dissolved oxygen throughout the system (Fafard, 2018; Wang

et al., 2019). In the spring and fall, this mixing causes nutrients trapped in the sediment to



reenter the water column, and there is an increase in primary productivity leading to
growth of plants and algae (Wang et al.,, 2019). In contrast to this, a pond ecosystem is fully-
mixed year-round, and typically has a surface area of less than two hectares (Black, 1996;

NJDEP, 2020).

Landscape Development and Hydrology

Where people decide to live, and what they decide to build in an area, will have an
effect on the landscape and ecology of the area. New Jersey is the number one most densely
populated state, and has a variable landscape consisting of different land use
characteristics. The northern region of the state consists of cities, suburban sprawl, farms,
and some areas of protected deciduous forest. The southern region is similar, with the
addition of pine forests and beaches. The limnology of the state is expansive and highly
variable; in total, New Jersey contains over 11,000 lakes and ponds, which range in size
from a few square meters to over 970 ha, and have a combined surface area of nearly 5,260
ha (NJDEP, 2020). The highest density of lakes is located in the northernmost three
counties—Morris, Sussex, and Passaic—with about 2 ha of lake surface per square
kilometer (NJDEP, 2020). The vast majority of lakes and ponds were created or
significantly altered by humans; the roughly 60-70 naturally-occurring lakes exist as a
result of glaciers receding during the last ice age and leaving behind depressions that filled
with water (NJDEP, 2020). New Jersey’s human-made lakes were created for a variety of
reasons, including recreation, drinking water, irrigation for agriculture, stormwater
management, and industrial purposes like mining, milling, and iron processing (NJDEP,

2020). Over time, urbanization of the state has led to decreased forest cover and increased



development. Since development affects the landscape characteristics of an area, and these
landscape characteristics influence water infiltration and flow, humans end up
inadvertently affecting these aspects of the water cycle.

Many ecological changes can happen when land becomes more developed. Removal
of forests near bodies of water often means that the ecosystem services in those areas, like
filtration and groundwater recharge, are lost (Arnold and Gibbons, 1996). Developed areas
often have increased pollution and more impervious surfaces, or surfaces that do not easily
allow water to infiltrate into the ground (Arnold and Gibbons, 1996). Examples of these
include buildings, paved roads, and parking lots. Turf lawns and lawns that are frequently
mowed can also function as impervious surfaces (Cao et al., 2012). When the roots of
grasses are unable to grow deep into the ground, they instead form mats near the surface
that water cannot easily pass through (Cao et al., 2012). Because less water is being
absorbed into the ground, increased impervious surface cover typically leads to increased
quantities of faster-moving surface water, or runoff (Arnold and Gibbons, 1996). Climate
change is also affecting groundwater filtration. Increased global temperatures are leading
to increased evaporation, which in turn causes longer periods of drought and higher
volumes of rainfall (Trenberth, 2011). Drought makes the soil less absorbent, so the
combination of these two phenomena means that higher volumes of water are falling in a
given period, and less of the water is percolating into the ground, increasing runoff rates
(Trenberth, 2011). Runoff water is capable of transporting a wide variety of pollutants,
including sediments, chemicals, nutrients, plastics, bacteria, and heavy metals, and
depositing them into nearby bodies of water (Arnold and Gibbons, 1996). The effects of

these contaminants on freshwater ecosystems are as varied as the pollutants themselves.



Nutrient Loading and Eutrophication

Pollution of excess nutrients, or nutrient loading, is a problem faced by many of New
Jersey’s freshwater systems. Lakes and streams need certain levels of nutrients such as
nitrogen, phosphorus, carbon, and oxygen in order to support a diverse community of
organisms (Vanni, 2002). These levels fluctuate in cycles but are generally balanced out by
the different biological processes carried out by the organisms living in the water (Vanni,
2002). The absence or excess of one or more of these essential nutrients can have
cascading effects on the ecosystem as a whole, and upsetting the balance too much can fully
disrupt the processes that keep the pond ecosystem functioning (Vanni, 2002). Nutrient
loading in surface waters is correlated with decreased levels of dissolved oxygen, and
increased levels of turbidity (Mahmud et al., 2020).

Nitrogen compounds like nitrate, nitrite, and ammonium are frequently found in
agriculture, and will typically end up in the ecosystem as a result of runoff from fertilizers
and animal waste (Mahmud et al., 2020). Nitrogen levels in lakes tend to peak in the spring,
and decrease in late summer and fall (Bhateria and Jain, 2016; Wang et al., 2019). Nitrogen
becomes bioavailable in an ecosystem through a process called nitrification, in which
organisms like Nitrosomas bacteria convert ammonium to nitrite, and Nitrobacter species
convert nitrite to nitrate, which is the form that most plants are capable of using (Randall
and Buth, 1984). Because oxidation of nitrite to nitrate happens relatively quickly, levels of
nitrate in an ecosystem are typically low (Randall and Buth, 1984). That being said, levels
of nitrite can increase due to excess effluent of wastewater and industrial sludge, and there

is a temperature threshold between 14 °C and 17 °C in which nitrite builds up because it is



produced faster than it is consumed (Randall and Buth, 1984). This can alter the rate of
nutrient cycling and the bioavailability of nutrient compounds in the water system.

Due to its natural origin from geologic weathering rather than biological processes,
phosphate typically occurs in the ecosystem at lower concentrations than nitrogen
compounds (Mahmud et al., 2020). It is tied to decreased levels of dissolved oxygen and
increased turbidity, and levels tend to peak in summer and fall (Mahmud et al., 2020; Wang
et al., 2019). An example of how nutrient loading can affect an aquatic ecosystem is
eutrophication, which is a process in which drastic increases in the amount of nitrogen and
phosphorus in a body of water lead to an increase in primary productivity by
photosynthetic organisms (Qin et al., 2013). Phosphate is a limiting nutrient to the growth
of many species of algae, so excess phosphate leads to near-unlimited algae growth,
clouding the water column and blocking sunlight from reaching submerged aquatic plants
(Qin et al., 2013). Harmful algal blooms (HABs) are the presence of excess toxic
cyanobacteria in the water, and often occur when extra phosphate is taken up by algae in
the water column (Qin et al., 2013). These algae blooms are harmful to human health
because the toxins released by some toxic blue-green algae can cause abdominal pain,
nausea, and diarrhea, as well as headaches, sore throat, and a cough (Morel, 2022).
Additionally, these cyanobacteria cloud the water column and make it hard for light to pass
through, meaning that eutrophic lakes and ponds often experience decreased biodiversity
when the base of the food web - aquatic plants - cannot survive (Qin et al., 2013).

One case study of eutrophication familiar to many New Jersey residents is Lake
Hopatcong, which began monitoring levels of toxic cyanobacteria in 2018, and has

experienced harmful algal blooms that shut down recreational activity in the lake for parts



of the summer every year since 2019 (Morel, 2022). Beach closures negatively impact the
economy of Lake Hopatcong, as well as the four municipalities surrounding it: Hopatcong,
Jefferson, Mount Arlington, and Roxbury (Morel, 2022). Excessive nutrient loading is an
issue that is not only relevant to ecosystem health, but to public and economic health as

well.

Water Quality Characteristics and Pollution

The chemical and physical characteristics of a body of water can provide important
information about the health of the ecosystem, and the community of organisms living
within it. Some of the most common characteristics that are tested by water quality
monitoring groups include temperature, dissolved oxygen, turbidity, pH, conductivity, and
total dissolved solids (Bhateria and Jain, 2016). Temperature needs will vary by organism,
but an optimal temperature range is one where growth, metabolic and immunological
processes, and photosynthesis can take place. If temperatures are too high or too low, or
change very quickly, organisms become stressed, and are more susceptible to diseases,
parasites, and toxins (Bhateria and Jain, 2016). Higher temperatures can also reduce
dissolved oxygen availability, since warmer water cannot hold as much dissolved gas
(Bhateria and Jain, 2016). Trees around the edge of a lake or pond provide shade and lower
the temperature of the water, so one common effect of development is increased
temperature due to the removal of trees (Arnold and Gibbons, 1996). Dissolved oxygen
levels are also important to monitor in a freshwater lake or pond. Bodies of water with a
high biological oxygen demand will deplete dissolved oxygen faster, and low dissolved

oxygen is stressful and even fatal to many organisms (Bhateria and Jain, 2016).



Additionally, high suspended sediment levels are correlated with lethal and sublethal
effects in fish, including damage to the gills, increased stress, and harm to eggs (Bash et al.,
2001). The acidity, or pH, of the water affects structures and can indicate changes in
organisms; water with a lower pH is more corrosive to some human-made structures, and
decreases in photosynthesis are correlated with increases in pH (Bhateria and Jain, 2016).
The ions dissolved in the freshwater of a lake or pond can be measured via two
characteristics: total dissolved solids, and conductivity (Bhateria and Jain, 2016). The
former measures all dissolved solids, and can be affected by fertilizer and road salt runoff,
as well as effluent from wastewater treatment plants (Bhateria and Jain, 2016).
Conductivity is correlated with the total dissolved solids content of a lake, as well as its pH
and temperature, however it is more associated with the bedrock characteristics of an area
(Bhateria and Jain, 2016). High levels of conductivity indicate the presence of clay soils and
potentially increased sewage effluent, while low levels are correlated with granite bedrock,
oil spills, and groundwater inflows (Bhateria and Jain, 2016).

Heavy metals and industrial chemicals that originate from construction sites are
often toxic to organisms; these compounds adhere to sediments, and will typically be taken
up by foraging organisms (Muneer et al., 2021). The concentration of these toxic
substances increases at higher trophic levels, which can have negative implications for the
health of people and ecosystems that rely on fish at the top of the food web (Muneer et al.,
2021). The toxicity of different metals can vary based on other parameters of the water.
Many metals are highly soluble in water with a low pH, so slightly alkaline water may
reduce the toxicity of some metals (Muneer et al., 2021). Additionally, hard water (water

with greater concentrations of calcium and magnesium ions) tends to reduce the toxicity of



many of these trace metals on freshwater invertebrates (Rathore and Khangarot, 2002).
Metals like copper, zinc, nickel, lead, and cadmium are more soluble in softer water
(Rathore and Khangarot, 2002). Having an understanding of the hardness and pH of a
freshwater system can help to determine what bodies of water may be more susceptible to
the toxic effects of industrial runoff.

One common pollutant found in New Jersey is road salt. This substance is most
commonly composed of sodium chloride (NaCl) and is used to prevent paved surfaces from
freezing in the winter and early spring (Jones et al,, 2016). In 2021, over 20 million tons of
salt were used to deice highways (Walton, 2023). When snow melts and rain falls in the
spring, much of the salt that was placed on the ground will be washed into aquatic
ecosystems, where it does not have any natural means of removal (Jones et al.,, 2016). This
increases the salinity of the water, and many aquatic organisms that have evolved to live in
freshwater will experience adverse effects when exposed to brackish water. Zooplankton
populations tend to decrease, and amphibians tend to be less active (Jones et al., 2016).
This issue is often worse in urbanized areas, or in areas with a greater amount of paved

surfaces (Walton, 2023).

My Research

The purpose of my research project is to study how pollution from human
development affects the water quality of lakes in Northern New Jersey. Water quality and
the presence of pollutants can be assessed through a variety of measures, both biotic (living
organisms like bacteria, invertebrates, and fish) and abiotic (nonliving factors such as

temperature, nutrients, and clarity). For my project, I chose to focus only on the abiotic
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components of water quality, which include nutrient levels (ammonia, nitrite, and
phosphate), pH, dissolved oxygen, temperature, turbidity, conductivity, and dissolved
solids (including calcium, magnesium, and sodium). While pH is highly variable based on a
wide variety of factors which contribute to a lake ecosystem, the other parameters can be
more reliably predicted. By testing for these components, I wanted to answer the question,
how does anthropogenic land use around New Jersey lakes affect the abiotic components of
water quality within those lakes? I hypothesized that increased levels of development
around a body of water would result in variable pH, decreased dissolved oxygen, and

increased nutrients, temperature, turbidity, conductivity, and dissolved solids.
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METHODS

Site Selection

Sites were selected based on the following criteria. All lakes and ponds were located
in two watershed management areas within the Passaic River Watershed. This was done
for the purpose of limiting what water bodies are naturally interacting, and which groups
might be monitoring them. Second, sites were located within a 20-mile radius of the Drew
University campus, due to restraints of time and expense. Finally, all study sites were
located within Morris County. This will allow me to control for the regulations placed on
different bodies of water as a factor of municipality. Although all counties are subject to the
same regulations at the state and federal level, Morris County has its own statute, known as
the County Environmental Health Act, which provides guidelines for how municipalities
should treat public health hazards, including (but not limited to) water pollutants (Morris
County, 2023). The Morris County Division of Public Health conducts surveys and
education programs related to non-community public water systems (Morris County,
2023). Because implementation of laws, the types of permits available, and the finances
available for enforcement of the laws will vary by county, study sites were contained to just

those within Morris County.
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Figure 1. Map of Morris County, N] showing my 14 study locations, and their contributing
lake- or pondsheds. Shades of green denote areas covered in forest, shades of red denote
development, and shades of blue denote wetlands and open water.
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For initial site selection, I used a combination of multiple online mapping programs.
The measurement and map notes tools in ArcGIS Online were used to make a list of
potential sites located within Morris County and within 20 miles of Drew University. I also
used the N] MAP Watersheds (beta) to determine which lakes were located within the
Passaic River Watershed (Rowan University School of Earth and Environment, 2023). The
Land Use/Land Cover 2015 dataset from the NJDEP Bureau of GIS to approximate which
lakes had mostly residential or mostly forest surrounding them (NJDEP Bureau of GIS,
2021). Two categories were created from this process: “Forested” and “Developed.” After
narrowing down to fourteen study locations, the list was divided evenly between the two

categories.

0 1 2 4 Kilometers 0 0.5 1 2 Kilometers 0 0.75 1.5 3 Kilometers
Green Pond - Forest Mountain Lakes - Mixed Use Kitchell Pond - Developed
3 Contributing Shed ] Developed, Medium Intensity
I Lakes Boundaries I Developed, High Intensity "
Land Cover Classification S Deciduous Forest
Evergreen Forest
NLCD Land Cover Class Mixed Forest
I Open Water Woody Wetlands
Developed, Open Space [ Emergent Herbaceous Wetlands

[ Developed, Low Intensity

Figure 2. Maps of three study locations, Green Pond, Mountain Lakes, and Kitchell Pond,
showing the land use characteristics within their contribution shed. Areas in shades of
green are forested, areas in shades of red are developed, and areas in shades of blue are
open water or wetland habitat.
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For final categorization of the study sites, and for statistical analysis, [ used a
pondshed analysis in ArcGIS Pro to quantify the percentage of different land use types
around each lake. Step one of this process was to create polygons that delineated the
bounds of each lake. Next, [ used a New Jersey digital elevation model to determine how
water moves over the land. This map layer was made up of raster data, or pixels, so it had
to be cleaned up, meaning that the pixel outliers were removed before it could be used for
analysis. The polygons created from this process were the contributing watersheds for
each body of water. The size of each lake- or pondshed varied greatly, with the smallest
being 10.44 ha, and the largest being 1,747.17 ha (Table 1). Lastly, I used the National Land
Cover Database (NLCD) 2019 map layer to quantify the area of each land use type within
each pondshed. This resulted in three categories: Developed, Forest, and Mixed Use.
Developed lakes and ponds had a contribution shed which contained over 50% of land
designated as “developed, open space” or “developed, low/medium/high intensity.”
Forested sheds were those which had over 50% of land designated as deciduous,
evergreen, or mixed forest. Five of the lakes that I tested are Developed, six are Forest, and

three are Mixed Use (Table 1).



Table 1. Size and Proportional Land Use of Contribution Sheds of 14 Study Sites

15

Study Location Size of Percent Forest Percent Classification
Contribution | within Shed Development
Shed (ha) within Shed

Sunrise Lake 193.50 91.91% 5.67% Forest
Splitrock Reservoir 1,094.94 80.68% 7.13% Forest
Canty’s Lake 15.48 81.40% 12.21% Forest
Green Pond 270.81 68.76% 21.97% Forest
Lake Kinnelon 512.10 63.44% 25.10% Forest
Taylortown 499.77 51.02% 30.61% Forest
Reservoir
Ledell’s Pond 849.60 40.11% 40.33% Mixed-Use
Indian Lake 1,747.17 42.50% 44.40% Mixed-Use
Mountain Lake 145.98 38.90% 46.12% Mixed-Use
Hedden Pond 824.67 35.68% 54.82% Developed
Lincoln Park 10.44 9.48% 65.52% Developed
Community Lake
Rainbow Lakes 94.41 19.07% 66.06% Developed
Lake Arrowhead 36.72 10.05% 73.28% Developed
Kitchell Pond 490.77 15.81% 77.39% Developed
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Field Work - Sample Collection and On-Site Testing

Before arriving at each site, [ received permission from the respective land manager
to gain access to each body of water. I collected water from each site around the same time
of day, typically between 11:30 am and 1:30 pm. The first step once arriving on site was to
collect all of the water that [ would need for my analyses. At locations where a dock
extended into the water, I collected water from the end of the dock. At locations without a
dock, I would wade into the water 1-2 m from the shore, then wait for the sediment to
settle before collecting samples. At all locations, water was collected from roughly 30 cm
below the surface. All glassware and sample vials were fully submerged and rinsed with
lake water three times before being used to conduct any tests, in order to reduce cross-
contamination from other sites. Two 50 mL sample vials were filled and capped
underwater to remove any air, and placed in a bag away from direct sunlight to be tested
later for concentrations of calcium, magnesium, and sodium at Drew University. This was
done to ensure that I collected as much water as possible, and to hopefully slow down any
biological processes that would continue to occur before the samples could be refrigerated.

Directions from the API Pond Master Test Kit were followed to determine the levels
of ammonia, nitrite, phosphate, and pH at each site. These were colorimetric tests, meaning
that a specific number of drops of different reagents would be added to a clear glass test
tube filled with 5 mL of sample water, mixed thoroughly, then left to process. The color of
the water in the test tube was compared to a key on the back of the directions, and viewed
in a well-lit area against a white background. Values were recorded in ppm. The number of

drops of reagent, time spent mixing the solution, and time spent letting the solution
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process varied based on each test. Solutions were disposed of in a plastic waste container,
and the test tubes used were rinsed with DI water.

While waiting for the chemistry samples to process, other tests were conducted. A
YSI Pro2030 handheld meter was used to determine the levels of dissolved oxygen,
conductivity, total dissolved solids, and temperature. The probe was inserted into the
water column until it was just submerged, swirled around slowly to pass water over the
dissolved oxygen sensor, then held still until values did not fluctuate quickly. The final on-
site test was a visual assessment of water clarity, using a LaMotte Turbidity Column. The
clarity of the water was recorded in Jackson Turbidity units, and the color of the water was

also noted.

Lab Work - Chemical Analysis using the ICP-OES

In the Drew University chemistry lab under the supervision of Dr. Andrea Lee, |
tested my samples for common ions found in solution. This was done using the Inductively
Coupled Plasma Optical Emission Spectrometer (hereafter, ICP-OES) from Agilent
Technologies. This instrument aerosolizes a solution of metal ions, and is able to identify
them by their emission wavelengths. The emission spectrum provides the information to
be able to quantify the number of ions in solution.

To prepare the samples for analysis, any debris or suspended solids were removed
by vacuum filtration. Samples were then acidified to 4% nitric acid (trace metal grade) to
ensure that all of the ions were dissolved and homogenized in solution. This dilution was
accounted for when calculating the final concentration of ions in each sample, using the

dilution equation M1V = M;V>. Samples were run following the standard operating
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procedure (SOP) for the instrument as written by Dr. Crowther from Drew University
(Appendix 1). The analytical method used to calculate the concentration of metal ions in
solution involved using a calibration curve with a set of standard dilutions of known
concentrations. An Agilent Calibration Mixed Majors solution containing calcium, iron,
potassium, magnesium, and sodium, along with an Agilent Aluminum Standard, were used
to make five standard solutions and a blank between 0 and 50 mg/L. The instrument uses
three replicates for each measurement. The equation from this calibration curve was used
to calculate the concentrations of sodium, calcium, and magnesium ions. Each curve had a

correlation coefficient greater than 0.995.

Statistical Analyses

For all data, assumptions of homogeneity of variances were met. For any data that
were not normally distributed, the following transformations were performed: a square-
root transformation was done on the dissolved oxygen (DO) data, a log plus one
transformation was done for turbidity, and log transformations were done for total
dissolved solids (TDS), conductivity, calcium, magnesium, and sodium. Data for pH and
temperature were normally distributed, so no transformations were necessary. The
Pearson correlation coefficient was found for each parameter. Calcium, magnesium, and
sodium were all significantly correlated with one another, and turbidity was significantly
correlated with calcium and magnesium, but not sodium (Table 2). A One-Way Analysis of
Variance (ANOVA) was run to determine if levels of pH, dissolved oxygen, temperature, and

turbidity varied significantly based on increasing levels of development. This test compares
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one dependent variable against one independent variable, so four separate ANOVAs were
conducted, one for each of the aforementioned parameters.

Because conductivity, calcium, magnesium, and sodium are all factors which vary
directly with total dissolved solids, these five variables were analyzed together. This was
done using a Multivariate Analysis of Variance (MANOVA), in order to determine if the
values varied significantly based on the land use around each lake. A MANOVA is capable of
comparing multiple related dependent variables, which is why it was used for parameters
that are significantly correlated with one another. Roy’s Largest Root was used as the test
statistic for the overall multivariate test, because it is more relevant when running analysis
on large groups of variables. The result of this test was that the variables overall were
significantly correlated (F(5, 8) = 6.391, p =.011). Tukey HSD Post-hoc analysis of the

results of the MANOVA was conducted using Tukey HSD.

Table 2. Pearson Correlation Coefficients

Mg2+ Na* Turbidity
Caz* r=.974 r=.784 r=.784
p<.001 p<.001 p<.001
Mg2+ r=.661 r=.762
- p=.010 p=.002

Table showing Pearson Correlation Coefficients for turbidity, sodium, magnesium, and
calcium. Values not included were not significantly correlated
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RESULTS

Lake Nutrients - Ammonia, Nitrite, and Phosphate
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Figure 2. Average ammonia, nitrite, and phosphate levels at lakes with pondsheds
containing predominantly forest, an equal mix of forest and development, and developed
land. Error bars were made using standard error.

There were not sufficient data to determine whether the levels of ammonia, nitrite,
or phosphate differed significantly based on the land use characteristics in the lake- or
pondshed of each study site. For concentrations of ammonia, four out of the six forested
lakes had detectable levels, one of the three mixed-use lakes had detectable levels, and four
of the five developed lakes had detectable levels (Fig. 2A). In terms of other nutrients, two
of the five developed lakes had detectable levels of nitrite, and one of the five of developed

lakes had detectable levels of phosphate (Fig. 2B, 2C). No mixed-use or forested lakes had

any detectable levels of nitrite or phosphate. Because of the limited amount of data
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available for these three nutrients, statistical tests were not run to determine whether land

use classification had any impact on the nutrient levels found.
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Figure 3. Average pH at lakes with pondsheds containing predominantly forest, an equal
mix of forest and development, and developed land. Error bars were calculated using
standard error.

There were no significant differences in pH levels at any of the sites when
comparing the land use characteristics within each contribution shed (Table 3). The

average pH across all lakes was 7.4, and the values ranged from 6.5 at the lowest end, to 8.0

at the highest (Fig. 3).
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Figure 4. Average temperature at lakes with pondsheds containing predominantly forest,
an equal mix of forest and development, and developed land. Error bars were calculated
using standard error.

No significant differences were observed in temperature between predominantly
forest, mixed-use, and predominantly developed lakes (Table 3). On average, the study

sites had a temperature of 26.7 °C, with the highest recorded temperature being 29.5 °C

and the lowest being 23.9 °C (Fig. 4).



Dissolved Oxygen

0.900

0.800
= 0.700
on

E 0.600
[=

()
80 0.500

X
© 0.400
=

o
= 0.300
©

2 0.200
'Q .
0.100

0.000

Forest Average

Mixed Use
Average

Land Use Type

Developed
Average

Figure 5. Average dissolved oxygen levels at lakes with pondsheds containing
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predominantly forest, an equal mix of forest and development, and developed land. Error
bars were calculated using standard error.

Dissolved oxygen levels did not vary significantly as a function of the land use

characteristics within each lakeshed and pondshed (Table 3). Across all lakes, there was an

average of 0.50 mg/L, and values ranged from 0.10 mg/L to 2.9 mg/L (Fig. 5).
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Turbidity
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Figure 6. Average turbidity at lakes with pondsheds containing predominantly forest, an
equal mix of forest and development, and developed land. Error bars were calculated using
standard error.

Although the data seem to indicate that turbidity may increase with increasing
levels of development, there was large variability in terms of standard error, and this trend
was not statistically significant (Table 3). There were not found to be any significant
differences in turbidity based on land use within a contribution shed (Fig. 6). On average,

lakes had a turbidity of 3.8 JTU, with the highest levels being 10.0 JTU, and the lowest being

0.0 JTU.



Table 3. p-values and Test Statistics for One-Way ANOVA tests
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pH Temperature | Dissolved Oxygen Turbidity
p-value .589 .384 .653 296
F-statistic | F(2,11)=0.555 | F(2,11) = 1.046 | F(2, 11) = .443 F(2,10) = 1.378
Table 4. p-values and Test Statistics for MANOVA test
Total Dissolved | Conductivity Caz+ Mg2+ Na+*
Solids
p-value .005 .005 .002 .007 017
F-statistic | F(2,11)=9.048 | F(2,11)=9.034 | F(2,11) =11.035 | F(2,11) =7.933 | F(2,11) = 6.004
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Figure 7. Average total dissolved solids and conductivity at lakes with pondsheds
containing predominantly forest, an equal mix of forest and development, and developed
land. Error bars were calculated using standard error.
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There were significant differences in average total dissolved solids based on each
land use classification (Table 4). Tukey HSD post-hoc analysis revealed that for both total
dissolved solids and conductivity, there was a significant difference between values at sites
with greater than 50% forest cover and sites with greater than 50% development (p =
.004). There were not significant differences between forested and mixed-use sites, nor
were there significant differences between mixed-use and developed sites. Forested lakes
had, on average, 122.1 mg/L of total dissolved solids, which was lower than developed
lakes, which had 486.5 mg/L, on average (Fig. 7A). Forested lakes had an average
conductivity of 0.1878 mS/cm, and developed lakes had an average conductivity of 0.7478
mS/cm (Fig. 7B). This means that highly developed areas are correlated with higher levels
of dissolved solids and higher conductivity, and highly forested areas are correlated with

lower levels of dissolved solids and lower conductivity.
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Dissolved lons - Calcium, Magnesium, and Sodium
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Figure 8. Average concentrations of calcium, magnesium, and sodium ions at lakes with
pondsheds containing predominantly forest, an equal mix of forest and development, and
developed land. Error bars were calculated using standard error.

For all three dissolved ions, the differences in concentration based on land use
characteristics within each contribution shed were significantly different (Table 4). Tukey
HSD post-hoc analysis of calcium concentration showed that values were greatest with
over 50% development, and lowest with over 50% forest cover (p =.002). This was also
the case for magnesium concentration (p =.006) and sodium concentration (p =.013).
There were no statistically significant differences between forest and mixed-use or mixed-
use and development for any of these three parameters. Forested water bodies had an

average calcium concentration of 10.173 mg/L, and developed water bodies had an

average calcium concentration of 33.847 mg/L (Fig. 8). Concentrations of magnesium had a



forest average of 3.028 mg/L, and a developed average of 12.390 mg/L (Fig. 8). Sodium
levels for forested sites were 20.500 mg/L on average, and developed sites were 90.617
mg/L on average (Fig. 8). Following the trends seen for total dissolved solids and

conductivity, greater forest cover was correlated with fewer dissolved ions, and greater

development was correlated with greater dissolved ions.

29
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DISCUSSION

The ions and compounds found in the water can provide information about the
specific types of pollutants that are entering a body of water. Testing for different
chemicals, and comparing the levels to acceptable limits found by scientific literature or set
by organizations like the United States Environmental Protection Agency (U.S. EPA) or New
Jersey Department of Environmental Protection (NJDEP), can help to determine the health
of the body of water. If a lake has levels of nitrogen and phosphorus close to or above
standard limits for the region, it may be experiencing runoff pollution from fertilizers (Qin
et al.,, 2013). If the water has significantly worse clarity than is normal for the area, the
water may have excess sediment, or there may be a harmful algae bloom (HAB) occurring
(Qin et al,, 2013). It is important to keep track of the water quality indicators of a lake
system, since many are used by people for fishing, recreation, and even drinking water in
some cases. Additionally, knowing what is normal for a lake today can help detect issues

like contamination early on, because there is a baseline against which to compare changes.

Dissolved Solids

Investigations into the types and quantities of dissolved solids in freshwater can
provide valuable insight into what may be influencing a given water system. The
concentrations of calcium and magnesium ions in water provide an estimation of hardness,
and the concentration of sodium ions, as well as measurements of conductivity, provide an
estimation of salinity (Black, 1996). I found that among my fourteen study locations, levels
of dissolved solids and conductivity were significantly greater at predominantly developed

lakes than at lakes with mostly forest. This result was consistent for concentrations of
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calcium, magnesium, and sodium ions. This pattern makes sense if a major source of
dissolved solids is the surrounding landscape, since developed areas typically have more
pollution due to increased human activity, as well as more impervious surfaces that
prevent the filtration of surface water (Arnold and Gibbons, 1996). This relationship
between urbanization and dissolved solids concentrations has been well-documented in
scientific literature. Pecorari et al. (2006) and Soucek et al. (2011) made note of it in their
respective studies on freshwater invertebrates. The relationship has also been documented
by Szklarek and colleagues (2021) in their review of the salinization of freshwater
ecosystems. My observations of how increased development leads to increased dissolved
solids in lakes and ponds make sense, given that New Jersey is so highly developed and
densely populated.

Of the three ions, sodium made up the greatest proportion of the total dissolved
solids. It is likely that most of the sodium in the water originates from road salt (NaCl). Salt
is applied when temperatures are around or below freezing in order to melt ice and snow,
making roads safe for travel, but the substance is limited in its ability to leave the
ecosystem once it is added (Szklarek et al., 2021). When rain and melting snow carry the
salt into bodies of water, it dissolves and accumulates over time, causing the salinity of the
freshwater ecosystem to increase (Szklarek et al., 2021). Salinization can slow down when
a lake or pond has multiple tributaries that allow freshwater to flow in and saltwater to
flow out, but the tributaries can also be affected by salt runoff, and over time increases in
salinity are still observed (Wright and Boorse, 2017). Runoff road salt pollution poses a
serious threat to lake- and pond-dwelling organisms, which have evolved to thrive in fresh

water, and can become stressed or even die if the salinity is too high (Soucek et al., 2011).
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Amphibians are one example of this. Because their skin consists of a semi-permeable
mucous membrane, most amphibians will passively draw in water through their skin
(Pough et al., 2016). If the salt levels of their environment are too high, water will be drawn
out of their bodies instead, leading to desiccation (Pough et al., 2016). Even if the salinity
levels are not high enough to be toxic, the increased energy required for osmoregulation
can result in decreased activity for some species of frogs (Jones et al., 2016). Soucek and
colleagues (2011) found that increased salt concentrations negatively affected multiple
species of freshwater invertebrates, including Sphaerium simile (fingernail clams), Gyraulus
parvus (planorbid snail), Tubifex tubifex (tubificid worm), and Ceriodaphnia dubia (water
flea). For these species, dissolved salt levels were toxic within a range of about 740 mg/L to
6,008 mg/L, when the hardness of the water was between 50 mg/L and 200 mg/L (Soucek
etal, 2011). Researchers found that S. simile was the most sensitive to salt presence, and
the toxicity of salt decreased with increasing water hardness for all species (Soucek et al.,
2011). High concentrations of salt can also have negative effects on the community
structure within a lake or pond, or even impact the mixing events within the lake itself
(Hintz et al., 2017). At salt levels less than 246 mg/L, the zooplankton community structure
of a lake was shown to collapse, affecting the growth of larval Ambystoma maculatum
(Spotted salamander), a species which is native to New Jersey (Hintz et al.,, 2017). The
seasonal mixing events seen in two lakes were halted because excessive salt runoff (Hintz
et al., 2017). The study location which I found to have the highest salinity was Kitchell
Pond, with an average sodium concentration of 197 mg/L. The majority of lakes and ponds,
however, had less than 50 mg/L of sodium. Most of these bodies of water are still below the

thresholds of toxicity for freshwater organisms, however since salt accumulates in a system
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over time, it is important to find solutions and preventative strategies to deal with road salt
pollution now, before salinity becomes too high.

The hardness of the water can have an effect on the toxicity of heavy metals to
freshwater invertebrates, since metals like copper, zinc, nickel, lead, and cadmium are
more soluble in softer water (Rathore and Khangarot, 2002). Harder water (water with
greater concentrations of calcium and magnesium ions) tends to reduce the toxicity of
many of these trace metals (Rathore and Khangarot, 2002). Additionally, Soucek and
colleagues (2011) found that hard water may also decrease the toxicity of sodium chloride
to freshwater invertebrates. Bhateria and Jain (2016) found that calcium is typically the
most abundant cation in freshwater ecosystems, but I found that sodium was present in
higher concentrations than calcium (Bhateria and Jain, 2016).

My research was conducted in the middle of the summer, months after the last time
salt would have been added to the roads, and every study location was found to have some
level of salinity. This indicates that pollution from road salt is a persistent threat to aquatic
habitats. Because salt persists in the environment long after it has been added, reduction of
the amount of salt pollution created is ideal. The best course of action to mitigate the issues
caused by salt pollution is to use alternatives to sodium chloride like calcium magnesium
acetate, although these alternatives are much more expensive to produce, and many are
less effective (Walton, 2023). Some methods of reducing the quantity and spread of road
salt include pre-wetting the mixture with water or vegetable glycerin, and slowing the
speed of the salting trucks to below 25 mph to reduce “bounce-and-scatter” (Walton,

2023). Another option is to mix calcium chloride or magnesium chloride with the sodium
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chloride, which increases the mixture’s overall effectiveness, and prevents it from leaving

the road as easily (Jones et al., 2017).

Nutrients

Levels of nitrogen and phosphorus compounds are capable of providing information
about the types of pollution that are found within a body of water. While ammonia is most
closely tied to biological waste, nitrogen and phosphorus in various forms are often found
in fertilizers, so their presence may indicate pollution from fertilizer runoff (U.S. EPA,
2023). Nitrite can also come from septic tank and sewage leaking (U.S. EPA, 2023). Both
nitrite and phosphate can originate naturally from the erosion of rocks (U. S. EPA, 2023).
Although ammonia, nitrite, and phosphate were detected at some of my study locations,
there were not sufficient data to conduct a statistical analysis on whether the NLCD land
use categorization of a lake had an effect on the nutrient levels in the water. The thresholds
at which these nutrients typically occur in a lake system likely are lower than my
equipment was capable of detecting, which may account for the lack of data. One study on a
lake system in China found that levels of nitrogen peaked in early spring around 1,500
ug/L, then decreased in late summer and fall to approximately 100 pg/L (Wang et al.,
2019). The same study found that phosphorus levels peaked around 130 pg/L in the
summer, and that lowest values were roughly 68 pg/L in the winter and spring (Wang et
al,, 2019). These values are naturally occurring in the range of micrograms per liter, while
my equipment could only test in milligrams per liter, so it is likely that my tests were not

sensitive enough to detect nitrogen or phosphorus compounds at most locations.



35

Rather than using a colorimetric test kit to test the samples, it would be appropriate
to utilize other methods which have lower thresholds of detection. There are a variety of
potentiometric and optical sensors for detecting ammonium, which have detection limits
ranging from 0.03 pum to 4.4 x 103 pm (Mahmud et al., 2020). In addition to potentiometric
and optical, there are many different amperometric sensors available to test for nitrite,
which have a comparable range of detection limits to ammonium (Mahmud et al., 2020).
This technology uses electrochemical sensors, and is advantageous due to its high
sensitivity, portability, ease of use, and cost-effectiveness (Mahmud et al., 2020). Because
phosphate exists in freshwater ecosystems at much lower concentrations than nitrogen
typically does, the technology to detect it needs to be more sensitive (Mahmud et al., 2020).
There are a variety of sensors that can use spectrophotometric, colorimetric,
amperometric, and even optical designs which have detection limits low enough to reliably
collect data on phosphate concentration (Mahmud et al., 2020). All of this being considered,
the fact that these three nutrients were detected at some of the locations in my study
indicates that further testing with more sensitive equipment is warranted.

Of the fourteen sites in my study, nine had detectable levels of ammonia, two had
detectable nitrite levels, and phosphate was detected at one. Lincoln Park Community Lake
and Kitchell Pond were the only locations where nitrite was detected, and Kitchell Pond
was the only location where phosphate was detected. Lincoln Park had a nitrite
concentration of 0.125 mg/L, and Kitchell Pond had 0.250 mg/L of nitrite and 0.250 mg/L
of phosphate. The maximum acceptable level of nitrite in drinking water according to the
EPA is 1.0 mg/L, which is greater than the levels at all fourteen study locations (U.S. EPA,

2023). Both of these lakes are relatively small with high amounts of human activity nearby,
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including lawns that are mowed and maintained, roads, and a man-made beach in the case
of Lincoln Park. Nitrite typically ends up in the ecosystem due to septic tank leakage and
mineral erosion (U.S. EPA, 2023). According to the Organization for Economic Cooperation
and Development (OECD), a lake is considered to be experiencing eutrophication if it has
greater than 0.035 mg/L of phosphorus (Qin et al.,, 2012). Although the nutrient levels at
Lincoln Park and Kitchell Pond are below the EPA drinking water standard, they are still
high enough to be considered eutrophic. Another method by which to determine if a lake or
pond is eutrophic is to evaluate the primary productivity of the water, which is done by

measuring the chlorophyll a concentration (Qin et al., 2012).

Water Quality Characteristics

Temperature, pH, turbidity, and dissolved oxygen concentrations are four
characteristics of water quality which are commonly used to monitor changes in the health
of a freshwater ecosystem. Many fish and invertebrate species cannot survive outside of a
specific range of these parameters. The ecosystem is balanced within this range, and levels
of any of these parameters that are too high or too low can result in death of organisms.
These are the least likely to be directly affected by runoff pollution and anthropogenic
changes around a lake, as they are also influenced by the size of the body of water, as well
as weather and seasonality. If humans move into an area where a lake was previously
shaded by forest and remove all the trees, the temperature in the area could increase.
Dissolved oxygen and pH are temperature-dependent, so they would likely be indirectly
affected, however these changes tend to be much more gradual, and more difficult to detect

without repeated testing. I did not find that temperature, pH, or dissolved oxygen levels
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varied significantly as a result of the land use within a given pondshed. Pecorari and
colleagues (2006) found that for a lake in Argentina where the western shore was highly
developed and the eastern shore was mostly undeveloped, the pH of the water was higher
near the developed shore (Pecorari et al., 2006).

Consideration of water clarity is also important to gain a full picture of the health of
a lentic ecosystem, and to understand what external forces may be affecting the water.
High suspended sediment content (or turbidity) can make it difficult for organisms with
gills to get oxygen (Qin et al., 2013). Additionally, suspended solids scatter light particles as
they pass through the water, and a high enough presence of suspended solids can block
light from reaching the bottom of the lake. This can negatively impact the ability of bottom-
dwelling plants to photosynthesize (Qin et al., 2013). Clarity can be influenced by both
particulate matter and microorganisms like algae. Given this, low water clarity is often tied
to other processes like eutrophication (Qin et al., 2013). I found that the turbidity of the
water in each lake did not differ significantly based on whether the lake was located in a
pondshed containing predominantly forest, mixed use, or developed land. The U.S. EPA
standard for drinking water quality is 1.0 Nephelometric Turbidity Units (NTU). All of my
data were gathered using Jackson Turbidity Units (JTU), however, these two units are
generally considered to be interchangeable for the purposes of field research (Myre and
Shaw, 2006). While land use does not appear to affect turbidity in the lakes that I tested,
the average levels found at every body of water except for Green Pond were above the EPA
drinking water standard of 1.0 NTU. Kitchell Pond stood out in this category, as its average

turbidity level of 10 JTU is ten times higher than the EPA standard.
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Implications for Water Quality

Water quality monitoring is important to maintain both human health and
ecosystem health. Tests like those which I conducted are carried out by many different
private, nonprofit, and governmental organizations. In addition to water chemistry
analysis, these groups also gather data on biological markers of water quality. These
include gathering plant and algae samples, culturing bacteria, and sampling communities of
zooplankton and macroinvertebrates. An analysis which is able to synthesize the biotic and
abiotic components of a limnological system is able to provide the most comprehensive
picture of the health of the ecosystem. Given the opportunity to carry out further research
on this topic, this is where [ would focus.

Generally speaking, the vast majority of the lakes that I tested were not heavily
contaminated systems. All of the values for each parameter were below the limits set by the
EPA. One location that is worth paying closer attention to is Kitchell Pond. Not only was this
the only site found to have detectable amounts of phosphorus, which is a limiting factor in
algae blooms, but it had high values for dissolved solids and turbidity. This lake is too small
for recreational swimming or boating, but it is fished in occasionally, and it is connected to
the headwaters of the Passaic River, which itself provides water to much of New Jersey.
I[ssues upstream have compounding effects the further downstream you travel, so
monitoring water quality and making note of red flags when they pop up is important for
protecting the health of the people who swim, fish, and drink the water. If excessive
phosphorus in Kitchell Pond leads to a significant growth of harmful cyanobacteria, and

those bacteria travel downstream to pollute the Passaic River, this could cause harmful
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effects to the people who fish in and obtain drinking water from the river. Monitoring the
lakes and streams in an area, can help prevent issues like this from occurring.

Educating the people who live in close proximity to these lakes about how their
actions affect the ecosystem is important to ecological conservation and public health. One
thing that I noticed while gathering my data was that most people are very curious about
the lakes that they live near. [ had many conversations with lake residents who had no idea
what a healthy lake should look like, or how they as homeowners might be influencing the
chemistry and biology of the water. Groups like the Great Swamp Watershed Organization
(GSWA) have programs like the School Water Monitoring on the Passaic (SWaMP) where
they provide chemical, visual, and macroinvertebrate tests to schools, so that students have
the opportunity to get involved with the environment in impactful ways (Great Swamp
Watershed Association, 2023). These types of programs serve two important functions:
students feel more connected to nature and how people are affecting natural ecosystems,
and the GSWA obtains data on the relative health of different freshwater lakes and streams,

which they can monitor for changes or issues (Great Swamp Watershed Association, 2023).
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Subject: ICP-OES: Inductively Coupled Plasma-Optical Emission Spectrometer
Author: M. Crowther

1.0 Purpose And Scope
This standard operating procedure presents a guideline for routine use of the Varian 710 ICP-
OES.

2.0 References
2.1 “Agilent 700 Series ICP Optical Emission Spectrometers User Guide”, Agilent
Technologies, 2010, Australia (Part Number: 8510230100)

3.0 Instrumentation
3.1 Varian (Agilent) 710 ICP-OES with horizontally oriented (axial) plasma and megapixel
CCD detector (177-785nm).
3.2 Computer with ICP Expert Il software (Version 2.0.5)

4.0 Before you start.

4.1 Confirm that you have enough argon (Ar, 98psi) and nitrogen (N2, 95psi) for your run. Ar

is used at a rate of about 360psi/hour and N is used at a rate of about 10psi/hour.
4.2 Make sure you have at least 100mL each of tuning solution and 2% solution of
concentrated nitric acid (blank) available. More tuning solution can be obtained by
diluting the stock solution 1:10 in 2% HNOs.
4.3 Sign-in with the instrument logbook and complete all entries. This includes a record of
the Ar and N> gas consumption.



5.0 Turning On the Instrument From Standby Mode (You must do this section with your
instructor.)

5.1 The instrument should be on, have N; purge, and the computer should be displaying the
‘Status’ page (Figure 1). If not, click on the ICP Expert Il software icon and then
‘Instrument Setup’.

5.2 Turn on the Ar at the tank, ball valve on the regulator, and needle valve on the wall.

5.3 Choose Help from the top menu bar, Content, and then ‘Screen Movies and Videos’
from the left menu bar. Play “Installing the pump tubing” video to see how to properly
connect the waste and take-up tubing to the peristaltic pump. Place the take-up tubing
in 2% nitric acid (blank). Turn on the pump using the ‘Pump On’ icon on top menu bar
on the ‘Status’ page (Figure 1) and ensure that your tubing is properly installed. Switch
to ‘Pump Fast’ to flush the lines and then return to normal flow. Lift the tubing out of
solution to introduce an air bubble and check that the flow through the pump is even.
Turn the pump off.

5.4 Switch on the water cooler (if it is off). The Peltier (detector) will switch on automatically.
The Ar gas must also be on.
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Figure 1. Status page.

6.0 Create a Worksheet (Go to 15.3 to create a Worksheet from a template.)
6.1 All data should be stored on the D: directory in the folder “Worksheets”. You can create

a worksheet to run your samples and store the results. From the main window, click
the Worksheet button. Choose ‘New’. Find the drive (D:), directory (Worksheets), and
folder where your data is to be stored for example, D:/Worksheets/CHEM 321 2019. To
create a folder, right click after choosing the Worksheets directory and choose ‘New
Folder’. Finally, put a name for your worksheet in the ‘Name’ field at the bottom of the
window.



6.2 Click ‘Save’. The Worksheet window should now appear with the new worksheet
loaded.

7.0 Developing a Method

7.1 Click on the ‘Edit Method’ button. The Element page with a Periodic Table should be
displayed (Figure 2). If you don’t see the Periodic Table, choose Periodic Table from
the View menu.

7.2 Element tab. Select the elements you want to analyze by clicking on each element in
the Periodic Table. The recommended wavelengths for analysis will be displayed and
sources of potential interference will also be displayed. Ensure that there is no
interferent or other analytical line close to the selected wavelength. If the interferent is
highly unlikely to be in your sample, you may decide to choose it, regardless. Also
consider the intensity of lines that are close for elements that may be in your sample,
but are not your analyte.

7.3 You can choose multiple lines for an element.

= = le]x)
= B 2 g0 0| 88y - |
LI > ycthod Editor
\Worksheet Method File Edit Wiew Tools Help!
gz oM m A . | I—
Edtbel Elment | Condions | Stsndsds | Mo |
Fint Me (51 — Table Calour Codes
i [Be BC [ W Anabte 3
Ha | Mg B[S P[S[O]&
¥_[a 5[ Ti [V [ [Mn]Fe | Co | Ni [CulZm] Ga|Gefs 5o [Br o I Uteme S 0
RE [ Sr | ¥ [ 2 [Nb[Mo| - [Au|Rk|Pd|Ag | Cd[n [Sn Sk |Te| 1 W 1 Intererent orly 0
Ts |Ba | La | FF [Ta | [Fe D= | It | Pt [Au|Aa] T1 [Pa] Bl -
Te [ Fr [NA [ [5m [ Eu [ Gd |76 [Dy [Ho[ Er [Tm[¥b] u] W Mulinle use
Th [ Pa [ U [ e {Po [ Cr | BR | CF[ Es [ Fr [Md [Ne | Ur |
Hydrogen (H)
Analysis Lines
U Label Element | Type | Wavekength Internal St Time S can Color | s |
1 |Cu213598 Cu Analyte 213598 None Edit
\f|Pb 220353 Fb Anate 220,353 Here e |
A [Zn 206200 Zn |Anate 206,200 Nore Delete...

Modified

(e .
15 Start % ICP Expert 11 for Vari...

Figure 2. Element Tab in Method Editor.

7.4 Conditions Tab. Proceed to the Conditions Tab on the Method Editor page (Figure
3). Use these default values.

7.5 Advanced Users ONLY: You can modify the acquisition parameters on the
‘Conditions’ page and use the ‘Read Spectrum’ button (red circle on Figure 3) to see the
results of your change. [Of course the plasma must be on and a sample aspirating.]
‘Read Spectrum’ can also be accessed via the Graphics menu. Keep the Power
between 0.9 and 1.4 kW. The nebulizer pressure can also be adjusted for maximum
intensity. Use the knob (and meter) on the front of the instrument and then observe
the results with ‘Read Spectrum’.



> - [=][x]

ABs &EL IR EIETL -+ |

Method 1 W» Method Editor

\Workshest Mathod File Edit View Graphics Cphiags Tools Help!
ER CHEE 4 |

Edit Met Element | Condiions | tandards 1 Mates ]
Pint M Qondcll\ogj;estas — Conditions used by: &l Lines s G|

W |Eu213 . Bower /), Intensity Cu 213598

|/ |Pb 220352 220282 2000

| Zn 208.200 30,200 Flasma Aows [L/min] co0d

Auxliary flowe [LAmin]: 4000

Mebulizer pressure (kPal

213852 213600 213636
Wavelencth (nm)
S: 6037 B: 202 SBR: 22,828

Replicate read time (s Intensity Pb 220.353

Instr stabilization delay [s):

Sample introduction settings

220305 220340 220391
Wavelength (nm)
S: BEOT B: 245 SBR: 26,781
Zn 206.200

Sample uptake delay (s)

Pump rate (ipm}.

Jad | d

Rinse time [s]:

I¥ Fast pump (Samp delay/rinse]

206.157 206.200 206236
WWavelsngth (nm)
S5: 1043 B: 57 SBR: 17.275
‘Wavelength: 0.000nm Intensity: 0 /s

General settings

.

Replcates:

Madified

T

vy Start T ICP Expert I1 for Yar... ordPad

Figure 3. Conditions Tab in Method Editor.

7.6 Standards Tab (Figure 4). Enter your standards and the concentration for each
analyte. Choose the correct units from the drop-down menu. Leave the correlation
coefficient at its default value (0.995). Choose a linear function for the calibration
curve.

7.7 Notes Tab. Use this space to record any additional information you want stored with
the method.

7.8 Choose ‘Save’ from the File menu to save your method. Choose ‘Exit’ from the File
menu to close the Method Editor.

8.0 Setting up your samples.

8.1 Click on the Sequence tab from the Worksheet window. Choose the ‘Manual’ button
on the right side. Click the Sequence Editor button and enter the number of samples
you will run. It is a good idea, however, to run a standard or two as samples just to
check the calibration.

8.2 Select ‘Begin with calibration’ and ‘Include a blank in calibration’. Check other boxes
when appropriate. Click on the OK button.

8.3 From the Sequence page, click on the ‘Sequence Parameters’ button. Set ‘On
calibration failure’ to ‘Stop’ and then ‘OK’.

8.4 Save your worksheet.
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Figure 4. Standards tab in Method Editor.

9.0 Preparing for Analysis. (You must be with an instructor when turning the plasma on.)

9.1 Place the blank in the take-up tube of the pump. Turn on the plasma by clicking the
‘Plasma On’ button in the top menu bar or or by pressing SHIFT+F4 on the keyboard.
The pump will be initialized and the solution will begin aspirating. The plasma will take
between 30 to 40 seconds to ignite.

9.2 The plasma should be on about 20 minutes before starting your analysis.

9.3 If an orange glow appears, the torch may be melting. Use the emergency off
switch on the front of the instrument near the mains power switch.

9.4 If you hear a “pop-rock” sound, the torch may be arching. Use the emergency
off switch on the front of the instrument near the mains power switch.

9.5 Advanced Users. Skip to 13.0 to perform a detector and wavelength calibration and
torch alignment.

9.6 Advanced Users. You may now choose to return to the Conditions tab in the Method
Editor to optimize parameters and/or do a trial run. Put the take-up tube into one of
your standards and click on the ‘Read Spectrum’ icon. If the spectra are satisfactory,
continue with the analysis.

9.7 Click on the Analysis tab from the Worksheet window (Figure 5). Make sure that the
standards and samples that you want to run are highlighted yellow. If not highlighted,
you can double click on the Tube number.

9.8 Click on the ‘Start Analysis’ icon in the top menu bar (green arrow) to start your
analysis.

9.9 Follow the system prompts to place your blank, standards, and samples into the
nebulizer.

9.10 You can stop the analysis at any time by using the red square icon on the top
menu bar.
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Figure 5. Analysis tab in the Worksheet window.

10.0 Your Data Analysis Results

10.1 Several error codes may appear in your analysis table. These include:

uncal - uncalibrated results

u - under-range (<blank)

v - under valid range (<minimum concentration)

X — extended calibration range (>maximum concentration)

10.2 What to do with an ‘uncal’ result. Your calibration may have failed because
“maximum error was exceeded” on the residuals (usually 10%) or “correlation coefficient
limit exceeded” (usually R?<0.995). These errors are printed out on the screen during
the analysis or appear in your printed report with the calibration data for the element.
You can also look at the calibration data by choosing the calibration icon indicated by
the blue arrow above. You can make several adjustments and have the software
recalculate the results.

10.2.1 Loosen up the error on residuals. Go back to the Method tab, then ‘Edit
Method’, Standards tab, and change the “Max % Error” in the table for the
element that is out of range. Do a File > Save to update the results.

10.2.2 Look for a bad replicate(s). Inthe Analyis tab, click on the run in
question (for example, element Cu and Standard 2). Go to Edit >
‘Replicates...” and look at the data for the element in question. You can
highlight (by clicking on) one or more (use Ctrl key) replicates. If you click
on ‘Mean’, all replicates are chosen. Choose ‘Mask’, then ‘Apply’, then
‘Recalculate’ to remove this data from the analysis. The data will now



have an “e” in the data table indicating that this data has been edited. You
can return and replace it if the analysis is not improved.

10.2.3 Change the correlation coefficient. While not recommended, you can
return to the Standards tab (Method tab, then ‘Edit Method’) and loosen the
requirement on the correlation coefficient. This will affect all elements,
however. Another option is to hand calculate any elements that did not
produce a calibration curve.

10.2.4 Other considerations.

10.2.4.1 Run areagent blank and a method blank as samples to see if
you have contamination form reagents or perhaps the
microwave vessels. Make sure you are using Trace-grade
reagents (acids). Also make sure your water is pure. You
could have high levels of Cu or even Pb in water from
piping/solder.

10.2.4.2 You may be able to improve the %RSD in your analysis by
changing the tubing in the peristaltic pump. Adjust the
pressure if the flow is not even.

10.2.4.3 You can change the peak marker (red bar on top of peaks) by
one or two (max) pixels if the it seems to be off the peak
maximum. To move the marker, use the Ctrl button so that the
cursor becomes a hand and move the marker in the direction
you want. Be careful not to move it off the correct emission line.

11.0. Print report.
11.1 Click on ‘File’ from the top menu bar and then ‘Report Settings’. You can preview the
report by clicking the ‘Preview’ button. Click the ‘Print’ button.

12.0 Shutdown — Standby mode.

12.1 The standby mode is recommended for day-to-day use. This mode keeps the

polychromator thermostating and purge systems operating.

12.2 Rinse the spraychamber by aspirating 2-5% nitric acid for 5-10 minutes and then water
for 5-10 minutes. Remove the tubing from the water and let the system (tubing, nebulizer
and chamber run dry (peristaltic pump still running). [The tubing that supplies the Ar gas to
the nebulizer should also be left dry and clean to prevent the nebulizer from clogging. See
the maintenance log for instructions.]

12.3 Turn the ‘Plasma Off (icon on the top menu bar or ‘Analyze’ menu)

12.4 Make sure the ‘PolyBoost’ is off (‘Analyze’ menu).

12.5 Turn off the peristaltic pump and loosen the pump tubing.

12.6 Turn off the water cooler (after 10 minutes).

12.7 Turn off the Ar gas at the cylinder.

12.8 Leave the main power switch on and the nitrogen gas on.

13.0 Shutdown — Shutdown mode.
13.1 Follow the shutdown procedure for Standby mode but switch off the Peltier (Analyze
menu) and the mains power switch after you have turned the plasma off (Step11.3).
13.2 Turn off the nitrogen at the tank, ball, and needle valve.



14.0 Advanced Users - Instrument Calibrations and Torch Alignment.

14.1 Detector Calibration. This measures the dark current. The plasma should be on and
the tuning solution should be aspirating.

14.1.1 Choose the ‘Calibrate Detector’ button. Updates are given on the bottom of
the screen. Wait until the calibration is complete.

14.1.2 Choose the ‘Store Dark Current’ button and save the results in a filename
“DC-09062012” , for example.

14.2 Wavelength Calibration.

14.2.1 For optimum wavelength calibration (especially if routinely analyzing lines below
190nm), check that the polychromator boost purge is on. To do this, click the
Instrument Setup icon on the main toolbar. Click the Status tab and check that
under polychromator, PolyBoost is ‘On'.  If the PolyBoost purge is ‘Off' turn it on
(for about 20 minutes before the calibration). To do this, choose PolyBoost On
from the Analyze menu in the main window. The PolyBoost uses a significant
amount of nitrogen. If not interested in lines under 190nm, you can do a
wavelength calibration with the PolyBoost Off.

14.2.2 From the Instrument Setup window, choose W/L Calib tab (Figure 6). The
plasma should be on and the tuning solution (5ppm) should be aspirating.
Choose the ‘Calibrate Wavelength’ button. Updates are given on the bottom of
the screen. Wait until the calibration is complete.

14.2.3 Record the ‘Drift (mm)’, the ‘Calibration Lines Used’, and the wavelength range in
the standards log.

14.2.4 You should do a wavelength calibration weekly or monthly.

14.3 Torch Alignment. If the torch has been adjusted or removed, you should realign the
mirror that optimizes the optical path through the torch. The plasma should be on and the
tuning solution (5ppm) should be aspirating.

14.3.1 From the Instrument Setup window, choose ‘Torch Align’ tab (Figure 7).
Click on the “Torch Scan” button.

14.3.2 Perform a horizontal scan first and then a vertical scan. Repeat the
horizontal scan.

14.3.3 Both offsets should be +/-0.5 range. If either value is greater than 0.5, the
torch should be cleaned.

14.3.4 Save the results in a filename “TA-09062012” , for example.

14.3.5 Record the horizontal and vertical offsets in the standards log.
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15.0 File Management (Advanced Users).

15.1

15.2

15.3

To create a new folder for yourself or your class: In Expert Il, go to File->New
from the top menu bar. Alternatively, click on the ‘Worksheets’ button and choose
“‘New”. Go to the D: drive and open the Worksheets directory. Now, right click and
choose ‘New Folder’ and create a folder to store your worksheets.  For example,
CHEM 321_2019. [Please store data in the D: drive ONLY]

To create a new worksheet: Find the folder that you created for yourself in 15.1
and then type the name of the worksheet in the ‘Name’ field at the bottom of the
window. For example, SoilMinors_2019. The worksheet will store the method
(elements, lines, standards, etc.), acquisition parameters, and results.

To create aworksheet from atemplate: You can copy an old worksheet for new
data collection. All or part of the template can be copied, the method, sequence, and
/or calibration.

15.3.1 After opening Expert Il, click on the ‘Worksheets’ button and choose “New”.

15.3.2 In the “Create Worksheet” box in the top left of the window, click on
“template”. Choose the source worksheet. Navigate to the place where
the worksheet you want to use as a template is stored and select the
worksheet

15.3.3 Click the Next button in the top right corner of the ‘New Worksheet’ window.

15.3.4 Now choose the destination worksheet. If needed, navigate to the folder
where you want to store the new worksheet or remain in the same folder as
the template.

15.3.5 Enter the name of the new worksheet in the ‘Name’ field at the bottom of
the window.

15.3.6 Click on ‘Next’ button. Select Method, Sequence, and/or Calibration
depending on what you want to import from the source file. Don’t check
‘Calibration’ unless you are NOT going to rerun the standards.

15.3.7 Choose OK.

15.3.8 You can now open the worksheet and modify the sequence table if you
have a different number of samples to run or other modifications and
resave the worksheet.

16.0 Maintenance. The following are routine maintenance procedures. See the Help screen
(F1) for Movies/Videos for more detail on the procedures.
16.1 Every six months: Remove the filter on the back of the instrument for the water

cooler. Sonicate the screen in hot water and replace. Refill the water cooler
(gallon of deionized water). Add an appropriate amount of algaecide.

16.2 Everyyear: Replace the Ar filter in the back of the instrument.
16.3 As needed: Clean nebulizer, spray chamber, torch.
16.4 Every year: Clean (vacuum) the air intake filter on top of the instrument behind

the exhaust.

16.5 Weekly: Replace the tubing on the peristaltic pump.

Agilent Support: 1-800-227-9770
ICP S/N: 1P1010M047
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